


Sales Representative __________________________________________ Customer Service Representative ________________________________________

In order to better serve our clients we are providing this checklist for your use.This checklist when completed and
submitted with your digital artwork will enable our “Preflight” specialist to quickly examine your artwork for items which
might delay production of your project or cause you to incur additional charges.

1. On which platform was this document created? ❑ Macintosh ❑ IBM Compatible (PC)

2. Disk Information: # of disks__________ Type of disk and size (ie. Zip, CD, DVD) ______________________________

3. Printed colors ❑ Process Color ❑ Spot (PMS) Colors ❑ Black Only

If spot colors or colors in addition to process color are required please list all PMS colors:

_______________________________________________________________________________________________________

4. What software packages were used to create the document(s)? (Check all that apply)

❑ QuarkXpress v._____ ❑ Adobe Photoshop v._____ ❑ Adobe Illustrator v._____ ❑ *CorelDraw v._____

❑ Adobe PageMaker v._____ ❑ Adobe Acrobat v._____ ❑ Adobe InDesign v._____ ❑ Freehand v._____

❑ †MS Word v._____ ❑ †MS Publisher v._____ ❑ †MS Access v._____ ❑ †MS Excel v._____

❑ Other(s) _____________________________________________________________________________________________

_____________________________________________________________________________________________________
† The Brandt Company cannot predict the integrity of Microsoft files unless you include a hard copy of the latest version of your file.

* If you have used CorelDraw, have you exported the file as an Adobe Illustrator file with all type saved as curves?
❑ Yes ❑ No This is required for proper output to the imagesetter.

5. Did you include on your disk(s) a copy of all graphics utilized in the layout? ❑ Yes ❑ No

6. In what formats are the graphics saved? ❑ EPS ❑ TIFF ❑ PICT ❑ JPEG

❑ Illustrator ❑ Photoshop ❑ GIF ❑ Other___________

7. If process work, are all images saved in CMYK? ❑ Yes ❑ No

8. What is the resolution of your raster images (not scaled within an application‡) __________ DPI [300 DPI preferred]
‡ Images that are scaled larger within an application will print with a lower resolution than the original graphic (i.e. A Photoshop EPS

that is originally 300 DPI, placed in Quark and blown-up 200% will now print at 150 DPI.)

9. If you require scanning by The Brandt Company prior to final output, please indicate:

Final size for printing ❑ Yes ❑ No Cropping ❑ Yes ❑ No Special Effects ❑ Yes ❑ No

10. Please indicate which fonts have been used in your document(s): _______________________________________________

_______________________________________________________________________________________________________

_______________________________________________________________________________________________________

_______________________________________________________________________________________________________
Have you included on your disk(s) all fonts used? ❑ Yes ❑ No Kind of fonts? ❑ Type1 ❑ TrueType

Please remember to properly print your project, you must include both screen and printer fonts (also known as bitmap and
outline fonts) for Type1 fonts.

11. Would you like us to archive this digital information for later use? ❑ Yes ❑ No

If after Preflight review, it is found there is a problem with the digital information supplied to The Brandt Company, we will
immediately contact the undersigned person to discuss the situation.We will offer to correct any problem and will provide
an estimate of the cost to perform this service.We will also offer to return the artwork to you for correction.

Company Name: __________________________________________ Contact: _______________________________________

Phone: __________________________________________________ Fax: __________________________________________

ISO 9001:2000Digital File Checklist
Phone: (563) 386-9740 • Fax: (563) 386-4817



This brochure is an informative tool for you, our
customer, to use to help you save time, money and
create a smooth running project.

Preflight
When The Brandt Company receives a file, the first step in our process is
to do a preflight. We are checking to see if all graphics, fonts, etc. that are
needed are included. The file then goes to one of the following two places:

1. If the file appears to be OK after doing the preflight, the file is copied
onto our system and the file name is added. It is labeled with a Brandt
Company job number. There is no charge for preflight if your files run
straight to proof.

2. If during the preflight, it is determined that the files need intervention,
your Sales Representative or CSR will be notified and you will then be
informed of the intervention needed and the cost to make the changes.
You will be charged $60 per hour or $15 minimum for the preflight if
your files require CSR involvement. You may select to have The
Brandt Company make the changes at the cost quoted by the CSR, or
you may choose to make the changes yourself. This may affect your
final due date.

Supported Media
•  Zip disks  •  CD  •  DVD
Also, we can retrieve files from the Internet at either:

• Email: prepress@brandtco.com
• FTP: www.brandtco.com

Sending Files
File Naming
Macintosh file names should not be longer than twenty characters, so it’s
easier to view the full file names in the directory windows.

PC file names should not be longer than eight characters, so that they
don’t get cut off in the translation between PC and Mac.

Collect for Output
In QuarkXpress documents it is best to do a Collect for Output. This grabs
all the graphics used and places them along with a copy of the Quark file
and a report in one central location. 

• First make sure you have all of your art updated and no duplicate names
are used; then save.

• Select File>Collect for Output, make a new folder called BRANDT and
Collect.

• When it is finished Collecting, import the report text into Quark and
print it out. This will be your check sheet and ours. On the report it will
list all the fonts used in the document, all the graphics used and any
required Xtensions.

• Then double check that all the graphics from the report are in the
BRANDT folder. Make a new folder in the BRANDT folder called
FONTS and copy all the screen and printer fonts listed on the report
into it. If necessary, make a new folder in the BRANDT folder called
XTENSION and copy all the Required Xtensions there.

Once all the necessary
files are placed in the
BRANDT folder, copy
it onto the disk. Print
the directory window of
all the files on the disk
and also open the
Quark document from
the disk and print a
laser copy.

Hard Copy Proofs
Hard copy proofs are a vital part of the proofing process and are
necessary in order to ensure the integrity of the final proof.
Consequently, you should provide The Brandt Company with the
following items for every project:

• A hard copy laser proof. This is used by The Brandt Company to
compare to the final proof as a quality control measure. Additionally, it
is critical that hard copy proofs are the same version as the supplied
electronic files for the purpose of this review process. 

• When proofs aren’t possible with files that are sent by modem, the
client should fax a hard copy proof that is 100% in size or tiled by the
laser printer if necessary. Then forward the original hard copy proof to
The Brandt Company via courier or overnight delivery.

• Only under emergency situations and upon explicit written instructions
from you, should The Brandt Company expedite the processing of the
electronic file without a hard copy proof. In this instance, The Brandt
Company will output a laser proof copy for a reasonable charge ($25 to
$50) and the client should accept complete liability for the processed
results.

Under circumstances which preclude the client from submitting a hard
copy proof, The Brandt Company should:

• Produce a proof from the electronic file; 

• Fax that proof to the client for the client’s approval; 
• Await the return fax of the proof with the client’s sign-off; and 
• Then and only then process the electronic file, with an additional

processing charge associated for this support. 

Hard Copy Proof Specifications
Proofs should be 100% in size. Tiling, while it may be necessary, is
preferred over off-size proofs because proofs not at 100% size create
potential scaling problems. For example, lack of image detail can result in
incorrectly sized and positioned images.  You should be sure to consider
the print area of your laser printers. Some printers have a non-printable
border.

Color Proofs
When outputting proofs for a spot or process color project, color proofs
are preferred. Color proofs can give The Brandt Company insight into
color breaks, the status of imagery (color or black & white), and any
potential trapping problems. If you are relying on black & white laser
proofs, Grayscale Mode should be used when printing proofs of color
pages. Black & white proofs of color pages in QuarkXPress should be
printed with Colors as Gray turned on. When black & white proofs are
used, you should:

• Print out spot color separations;
• Clearly label all four-color images as 4/C. 
Tiled proofs should be complete and taped together as a page or a spread.
It is best not to paste proofs to a board.

Handwritten instructions can clarify aspects of a client’s proof, making
the project more efficient for the client and for The Brandt Company to
process. In general, mark up proofs as if they were a tissue overlay of a
mechanical or keyline.

Proofing Spot Colors
Fifth or spot colors are to be printed on a separate proof and attached to
the top of the composite proof. This lets The Brandt Company know if
a color needs to be a spot color or a process tint match. It will also let
the client review color definitions to ensure that colors are defined
correctly.

Defining Blends and Dégradés
Avoid creating blends between spot colors. It may work on the computer;
it probably will not proof or output correctly.

Collect for Output window on a Macintosh.



Images
First, you should tell The Brandt Company about any images that appear
on the proofs. 

• Are they For Position Only scans (FPOs), which the client expects The
Brandt Company to replace with scans from The Brandt Company’s system? 

• Are they Live images such as illustration files or high-resolution scans
that should be used for output? 

While artwork should always be labeled as either FPO or LIVE, unlabeled
desktop scans generally will be treated as LIVE.

Fonts
To ensure font substitutions do not occur, The Brandt Company requires that you
supply all fonts used in your document. We maintain an extensive font library, but
we may not have the font used in your file. Since there are many vendors who
provide different versions of the same fonts, our fonts may not match yours.

Macintosh users should supply both printer and screen fonts for
PostScript fonts or just the Suitcase for True type fonts.  If System 10 “d
fonts” are used, these fonts should be supplied as well.  Fonts are usually
located in the System Folder, or in System 10 in the Library/Fonts folder.

PC users should supply the True type font. To access these fonts select Start
menu > Settings > Control Panels > Fonts. In the resulting window, select the
font you need to supply, then Edit > Copy, finally go to the folder you wish to
place the font in and Edit > Paste. In icon view True type has two T’s (TT) with
a .ttf extension. PostScript Type 1 fonts some have “A” icon and .pfm (screen
font) and .pfb (printer font) extensions. Window operators should know about
fonts if they are assuming the responsibility of building pages for printing. You
should be careful when selecting a style attribute from the Measurements
palette, such as Bold Italic, which may not be available as a printer font. 

An example of this problem might be selecting Humanist 541 Condensed
Bold (which has a corresponding printer font) and applying the italic
command at the application level. On screen the font will display as a
condensed bold italic. When printed, however, the user will most likely
get the condensed bold version with no italics.

Page Building Guidelines
Page clean-up. Avoid cleaning up an area of a page by covering the
problem with a white rectangle. The covered area still needs to RIP,
potentially causing a printing error.

Reducing (scaling down) Graphics
Avoid reducing graphics by large amounts. This still requires the RIP to
process the full extent of the graphic’s detail. For a scan, open the image
in Photoshop and resample it to the actual size required. For an illus-
tration, open the image and simplify the paths if possible.

Generally, documents should be created at trim size. Allow for a bleed in
QuarkXPress, for example, by creating elements at nine points (.125") off
the trim side in any bleed direction.

Text Handling and Text Special Effects
Outlines. Text outlines should be created in drawing programs and saved as an
EPS file for outline effect. Software used to create this effect should be tested
and reviewed by The Brandt Company. To create an outline in FreeHand,
Adobe Illustrator, or other object-oriented drawing programs, do the following:

• Set the original text in a text box applying all attributes of kerning, font,
point size, leading, horizontal scaling, color, and so on; 

• When text is final, save the document for future editing; 
• Convert the text to an outline in Illustrator or to paths in FreeHand; 
• Save in Illustrator or export in FreeHand. Be sure to include the original

FreeHand document when sending such projects to The Brandt Company.

Drop shadows without outlines. Drop shadows can either be created
within the page layout program or by using a drawing program that will
produce an EPS file. It is very important to note that a shadow be a
separate, editable and definable element, which means that clients should
be careful not to use the shadow attribute. Using the shadow attribute
makes kerning awkward and limits the possibilities of color and offset.
The preferred method of creating a simple drop shadow (no outline
included) in QuarkXPress is as follows:

• Set the original text in a text box on the pasteboard applying all attributes
of kerning, font, point size, leading, horizontal scaling and so on; 

• Select "Step and Repeat" to duplicate text at the desired shadow offset; 
• Apply color/tint to shadow text; 
• Send the shadow text box behind; 
• Select original text box and make it transparent by selecting None for

color background under the Modify menu; 
• Group the two text boxes and position on layout. 

Rule and Border (Frame) Specifications
Do not use a predefined hairline width rule in any application. Keep in
mind that predefined hairline rules vary in width between different appli-
cations and output devices. This is a very imprecise tool, which can
become totally unusable when output on a high-resolution device such as
an imagesetter. Instead, define hairline width rules as .25 point.

Wherever possible, do not use rules to create frames. It’s extremely
difficult to align rules to create perfect corners. Even though certain sides
of frames (such as in the creation of ads) may be bled off the page, it is
highly recommended to use frame options within the applications, even if
that means that part of the frame bleeds off the page.

Working with Images
Maintaining links. When a file is printed, graphics that have been placed
on the page are sent separately to the imagesetter RIP. The page layout
program must find the graphic in order to send it.

Page layout programs look in two places for linked graphics. First, they
look in the folder in which the layout file resides. Second, they look in
the pathname associated with the imported graphic. You must ensure that
the file is available in one of these places in order to successfully output
the job. Don’t change graphic file names. Changing graphic file names
once the graphic is placed will break the links. Also, don’t have two
graphics with the same name placed in the document. If both are sent to
the RIP, the first graphic it finds will be the one that it uses for both.

You should restrict desktop scans to single subjects, as opposed to ganged
scans (several items scanned as one image). Multiple-subject images
increase the size of the electronic document resulting in increased
processing and proofing times. If you create a ganged scan, convert it to
separate images with a minimum of crop using the cropping tool in an
image editing program such as Adobe Photoshop.

Any live computer image files should be supplied in a CMYK format, as
opposed to RGB.

Encapsulated Postscript (EPS) Images. Page layout programs treat EPS
files as electronic pickups. After placing EPS files in a page layout
document, do not rename EPS files. The EPS file name is the link
between the page layout document and the EPS file.

QuarkXPress Considerations
It is strongly recommended that the predefined base colors of red, green,
and blue be removed from the default color palette of your Quark
document, as well as any colors that you may have defined in general or
in your template that you did not use in the document. This will greatly
speed up processing time.

Spot colors in EPS files. When using a spot or fifth color in an EPS file
placed in QuarkXPress, you must define that color in Quark with the

In Photoshop you can tell in the
title bar if you’re in CMYK or RGB

Measurements palette from QuarkXpress

This is what the Macintosh True Type, Screen and
Adobe Printer fonts icons are. The fourth is the
suitcase which holds the screen font. Printer font
icons vary depending on the maker.



identical name specified in the EPS file. Otherwise, Quark will treat the
spot color as a process color. The same is true for the colors used to create
duotones, tritones, and quadtones in Adobe Photoshop.

Naming conventions. Note that FreeHand, Illustrator and Photoshop do
not use the same naming conventions for Pantone colors that
QuarkXPress uses, so you will need to edit the default color names in one
of the programs as you create them.

Creating and Defining EPS and TIFF Files
Minimize nesting. Try to minimize the nesting of EPS files. Printing an
EPS within an EPS increases the chance that the file will not RIP
correctly in PostScript. Generally, if it won’t print to a PostScript laser
printer, chances are The Brandt Company may have the same or similar
problems during production. Nesting EPS files also creates linking
problems between applications that may cause unpredictable results.

To get the same results as nesting when using FreeHand, copy and paste
from the original FreeHand document to the new document instead of
importing the EPS. When using Adobe Illustrator, open and copy illustra-
tions instead of place.

Bitmaps in object-oriented EPS files. Beware that placing scanned
subjects (TIFFs, PICTs, etc.) inside an object-oriented EPS file can also
sometimes crash the RIP, causing problems similar to nesting EPS files.
If this hinders a needed effect, contact The Brandt Company’s
Electronic Prepress Manager or Customer Service Representative
(CSR) for a work-around or a test.

Avoid ganging images. Avoid ganging images and cropping in
QuarkXPress or PageMaker. Restrict object-oriented EPS illustration
files to single subjects. In other words, avoid having several illustrations
in one EPS file that are usually viewed in individual QuarkXPress or
PageMaker graphic boxes or windows. For example, multiple logos
should be individually cropped rather than grouped in one EPS file for
use in layouts. PostScript RIPs (both in laser printers and supplier’s
high-resolution imagesetters) process the entire EPS file even though

only a small part is showing through the cropped windows. This results
in huge productivity losses and possible additional charges to process
the file.

Adobe Photoshop Considerations
When clients do the task of scanning in images and supplying us with
electronic files, they are taking responsibility for the quality of the printed
reproduction. Because The Brandt Company may have higher quality
monitors, calibration tools, and proofing devices, clients may wish to
arrange for The Brandt Company to color correct images they manipu-
lated for special effects.

• The Brandt Company should be able to provide a proof of the high-
resolution continuous-tone images that clients have modified on the
desktop. All customer image manipulation should be completed and
submitted with the final electronic file; 

• Mark this image on the hard copy proof as LIVE. 

Live effects in Adobe Photoshop can be created, but be aware of some
common problems:

• When an Illustrator/FreeHand EPS file is opened and saved in
Photoshop, it is converted from an object-oriented image to a scan-like
bitmap image. It will no longer self-silo over pictures or maintain hard,
clean edges on the page; 

• Adobe Photoshop-created drop shadows cannot be combined with
underlying images in QuarkXPress to darken the underlying images as
though they were covered by a shadow; 

• Soft shadows on top of a background scan require retouching/merging
of the shadow and the background images on the live scan; 

• Always test the output well before a deadline if you nest an Adobe
Photoshop-created EPS within graphics created in Adobe Illustrator or
FreeHand. Sometimes nesting will work, but it can cause output
problems. 

• Quick Reference of Various Photoshop and Illustrator Windows •

Saving as an Illustrator EPS window
on a Macintosh.

Saving as a Photoshop EPS
window and Options window
on a Macintosh. Make sure
your files look this way.

Photoshop Image Size window on a Macintosh. Make sure
your file is scanned in at 300 resolution with pixels/inches
increment.

Saving as a Photoshop TIFF
window and Options window
on a Macintosh. Make sure
files look this way.

Photoshop Windows

Illustrator Window
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